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Creating the Electronic Arab AtlasProject
Lesson One

Atlas: away to explore the world through a book featuring geographic maps and related to a specific topic

like continents and countries. Examples of such Atlas: World Atlas, Atlas of Africa, Arabic Atlas. The

evolution of the information technology is accompanied by the development of Atlas; the traditional printed

Atlas turns out to be a digital or electronic one available on line through the Internet or saved on compact

discs.

Examples of (Electronic Arabic Atlas) Program

There are many programs that enable you to view the world maps, and get information about countries and

continents.

 These programs contain also comparisons among countries concerning area, population number,

temperature, air pressure, wind, ..etc.
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Workshop (1)

The Required Data to Create Atlas Project:-
1- Text Data such as names of continents, names of countries in every continent, data for each state, the

name of the capital, the most important ports, the flag ,the anthem, sources of water…..
2- Graphical Data and Images such as the flag images and images for tourist places.
3- Sound Data as anthem.
4- Determining the software required to create the project.

nformationIAdditional

-:Multimedia

The term (multimedia) is composed of two parts; the first part is (Multi)which means multiplicity
, and the second part is (Media) which means media carrying different information such as
(audio, image and video ) including optical discs(CDROM), which aims to achieve efficiency in the process of
teaching and learning.

-:Advantages of Multimedia in Education

1- Making learning process enjoyable and interesting
2- Facilitate getting information.
3- Saving time and effort for both “teachers and students”.
4- Catching attention to the exposed information in order to understand and retrieve it easily.
5- Helping in presenting information in several ways to cope with different levels.
6- Exploring what is new in “Information Technology”.

-lements:EMultimedia
1- Data or Information: -which can be in a form of text, image, sound and video clip.

2- Hardware: which are the required devices to deal with “Data or Information” such as digital camera and
scanner.

3- Software: are programs and applications used to deal with data and Information such as “Movie Maker
Program”, “Sound Recorder” and “Windows Media Player”.
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Problem Solving Stages

efinition.DProblem-1

Define the problem, required output and available inputs.
utputsODetermining the-2

The outputs are the important information and results obtained after solving the problem.

putsnIne theimeterD-3

The inputs are data available that can be obtained from several resources, such as books, encyclopedias and the
Internet, etc., and these data will be processed to obtain the required output.

Develop an Algorithm-4

We set a logical sequence of steps; these steps are called (Algorithm). To illustrate this sequence of steps; many
tools can be used the (Flowchart) is one of them.

rogramPomputerCCoding a-5

We have already planned for solving the problem, when using computer we have to translate the steps of solving
problem; into an application using one of the programming language.

ebuggingDProgram Testing and-6

The aim of this phase is the implementation of the code that has been written, then  testing  this  code  using
diverse  values  (input), displaying  the  results (output),and then making the necessary corrections in case of
errors.

Program or Project Documentation-7
You can document the program or project by doing the following:
- Write the goal of the project (“programming project”), name of the programmer, creation date and the software
version number.
- Save program or project in the appropriate storage media.
- Print program or project and keep the printed papers within a folder in a safe place.
- Add help or a guide for usingthe program or project.

- You can make an executable (EXE) version of the program or project; so that it runs directly
through the operating system.
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Analysis of the Project Interface

Follow the stages of solving problems when creating the project; as follows:-

emlboprthet: IdentifysriF

The problem is: To create an '(Electronic Arabic Atlas)' program.
Second: Identify project output.

The output is: Plan a design for the project interface.
Third: Determine project inputs.

Intended project’s requirements of data and information with different types (text,graphical, audio
and, video).

Workshop (2)

Problem Definition:-
The problem is creating "Atlas of the Arab"

The requirements for the project:-
Firstly, we need to answer the following questions:
• What do you need to build “Materials of Atlas Project"?
• From your previous experience, determine a programming language to develop the new project.
• What are the required data?
• What are your data resources?
• What are the expected outputs from the program?
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Questions on Chapter (1)

-:)X(or)√(PutQ1)

1-You can get the data required to solve any problem through the stage of identifying inputs. (    )

2-Thestage"TestandDebug the Program Errors" in the problem solving stages is to write a program coding
by using one of the computer languages. (    )

3- After setting a plan for solving a problem; you can define the problem. (    )

4-The program documentation is the final stage in the problem solving stages. (    )

5-Data related to a specific project are collected after creating this project. (    )

Choose the correct answer of the following:Q2)

(1) The stage…………… is considered the first stage of the problem-solving stages
(A) Identify the problem (B) the program documentation
(C) Coding the program                     (D) test and debug the program errors

(2) The stage which precedes writing program code is ...........................
(A) Identify the inputs. (B) Determine the outputs. (C) Problem definition.  (D) Developan (Algorithm).

(3) Transferring (Problem Solving Steps) into an application using one of the programming languages is
called ………….stage.
(A) Determine the output                  (B) Coding the program using a computer
(C) documentation of the program or project     (D) Develop an Algorithm

Briefly mention what is meant by the following:Q3)

1. " Define the problem "...........................................................................................
2. " Determine the outputs ".......................................................................................
3. " Coding a computer program"..............................................................................
4. " Develop an Algorithm"........................................................................................
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Lesson Two
Managing Project’s Data

Internet & Operating System
1-Creating a Folder:-
To Create a New Folder at the Desktop:

1) Clicking the right mouse button at an empty area on the "Desktop", the following shortcut menu appears.

2) Choose “New”.
3) Choose “Folder”.
4) Notice that a new folder is created with the name "New Folder".
5) Write “Atlas of the Arab”, then press "Enter" key, to replace the name “New Folder”.

2-Deleting a Folder:-
1) Clicking the right mouse button at folder which you want to delete.
2) From the shortcut menu, choose "Delete".

3-Renaming a Folder:-
1) Clicking the right mouse button at folder which you want to rename.
2) From the shortcut menu, choose "Rename".

Workshop (1)
Creating Project Folders

Create the main folder with the name of "Atlas", and then under it create the following folders to
save the needed data.
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Searching through the Internet:-

1- Search Engines:-
1- www.google.com
2- www.yahoo.com

1-Downloading files (audio - video - image- .....):-

2-Searching inside electronic encyclopedias:-

"Electronic Encyclopedia" is a summary of the human knowledge in each specialization in a particular field
and is arranged according to a certain method as alphabetical order in order to facilitate research and access to
information.

The Advantages of "Electronic Encyclopedia":-it is a type of reference work which is a summary of
information from either all branches of knowledge or a particular branch of knowledge.
Some modern encyclopedias, as Wikipedia are often freely available.

www.google.com
www.yahoo.com
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Some of the most important encyclopedias "URL" is:-
http://en.wikipedia.org/wiki/Main_Page
http://ar.wikipedia.org/wiki/

Organization of Encyclopedias:-
1- Sorting by alphabet.

2- Sorting by scientific classification or by topics.

Workshop (2)

-Search for files (Map - Flag - National Anthem - ....) for the Arab countries:-
(Egypt - Sudan - Libya - Tunisia - Morocco - Saudi Arabia - Kuwait - Oman – Qatar –Yemen) and savethem in
the folders.

http://en.wikipedia.org/wiki/Main_Page
http://ar.wikipedia.org/wiki/
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Lesson Three
Data Collection by Using a Spreadsheet

Spreadsheets applications are programs designed for collecting data in an organizing way. You can enter and
manage data easily; you can also retrieve the enquired information.

What is meant by the electronic spreadsheet?

1- Workbook:-Excel files are known as " Workbooks ",each "Workbook" contains sheets that are
composed of columns and rows.

 The intersection of a column and row is called a "Cell".
 Each "Workbook" contains three sheets.
 The default name of the "Excel" file is "Book1" till you save the file under another name.
 Columns headers are " A, B, C, …. Z, Aa, …. "
Rows headers are " 1, 2, 3, …….

There are three basic types of data that can be entered into the cell.

Text, numbers, or mathematical formulas can be entered into the cells.
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on chapter (2 and 3)snoitsQue

:skne blahtnillifnehtdna,elbatgwinollofeht) Read1

a) The shown table is formed of………..rows, and………… columns.
b) Each row represents…...…...and each column represents a field.
c) ………… ,…………. and ………………….are fields in the table.

2) Mention the types of data you can enter in Spreadsheet cells:
a)……………… b)…………………        c) …………………
3) Can other types of data (pictures, sounds, and videos) be entered in table cells?
…………………………………………………………………….
Q2) Put  ( √) in front of the right sentence and sign ( X ) in front of wrong sentence:-

1-Electronic encyclopedias are considered one of the search engines on the Internet. (    )
2-It is better to name folders with names suitable for the content of its files and folders. (    )
3-The site www.google.com is one of the search engines for searching information through the Internet. (    )
4-Encyclopedias are considered a special kind of references that provide the most important information and

facts related to various human knowledge or part of it. (    )
5-A File consists of a group of files and folders. (    )

Q3) Choose the correct answer of the following:-

1-a single folder may contain ..............................
(A) multiple files. (B) several folders
(C) empty folders. (D) all of the above

2-The following Internet sites are considered one of Search Engines except….
(A) www.twitter.com. (B) www.google.com
(C) www.yahoo.com. (D) www.Altavista.com

3-Electronic encyclopedias are characterized by ........................................
(A) Fast and easy search for information.
(B)The diversity and enormousness of the forms of information
(C) Lack of information inside them.
(D) Both (A) and (B)

Q4) What is the purpose of using electronic encyclopedia?

................................................ ..................................................

.............................................. ..................................................

www.google.com
www.twitter.com
www.google.com
www.yahoo.com
www.Altavista.com
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Creating the Spreadsheet.
Workshop (1)

1- Students create a workbook to enter the following data (the continent - the state - the capital - the most
important ports - water sources).

2- The students rename the worksheet with the name(State Data).
3- Students save the workbook with the name (Continents Data) under the following path
"F:\ Databases".
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Lesson Four
Dealing with Images through Editing Software& Image Processing

1-CinePaint (O/S Linux )
http://www.cinepaint.org

2-PicsArt (O/S Android)
http://play.google.com/store/apps/details?id=com.picsart.studio&hl=en

3-Paint.NET (O/S Windows)
http://www.getpaint.net/download.html

e:kilsnoisntexerenteffideavhtahtseilfeagmisofepytlarevere saThere
Bmp- gif–eps-jpg-pcx–png- wmf -tif-..etc.

naimowded intotiviy dlefirebraputermongthecsiy by ulapisrdoectollecwtacturesthifpopesyetmoS**
-puter:mode thecsinginessitsprocingtoirdcotypesac

:scihparr GotecV-1

• They are based on mathematical expressions to represent images in computer graphics.
• They are not affected by scaling (enlarging or reducing their size)
• They are characterized by their small storage size

their type such as eps, emf and wmf.

-:Raster Graphics-2
• Raster graphics imageis a dot matrix data structure
• raster images are affected by scaling (enlarging or reducing their size)
• Raster files are characterized by their large storage size
• Their type such as raw, bmp, tiff, gif, jpg, png.

http://www.cinepaint.org
http://play.google.com/store/apps/details
http://www.getpaint.net/download.html
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-The characteristics of some picture types:
-:typeThe raw

• This type can’t support the animated picture.
• The size of the picture is very big.
• A few programs to deal with this type of picture.
• This type can save a picture in high qualitycompared with jpg.

-:p typemThe b

• It is a type of fixed picture files that support neither transparency nor animation
• We can deal with it through well-known operating systems specially “Windows”
• It is mostly of a big size and high quality and high colors compared with gif.
• The “.bmp” extension is an abbreviation of (Bitmap).

-type:figThe

• This type supports animation and transparency.
• It is inadvisable to use it in saving pictures of high number of colors and gradients colors; in order not to

be distorted.
• It‘s advisable to use it for simple pictures that have few colors and of small sizes.
• The “gif” extension is an abbreviation of (Graphical Interchange Format).It has 256 colors

-:The jpeg type

• This type of extension doesn’t support neither animation nor transparency.
• Where the team of (Joint Photographic Experts Group) has developed it, so it carries his name.
• This type has other extensions: “jpe” and” jpg”.
• Digital cameras support it and we can find it mostly on web pages.
• It has 16 million colors.

-:The png type

• This type supports transparency and doesn’t support animation.
• It handles million colors.
• It’s advisable to use it with pictures that have transparent background even if it has a lot of colors

and gradients ones.
• This extension is an abbreviation of (Portable Network Graphics).
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-:The wmf type

• This type supports transparency and doesn’t support animation.
• It is based on mathematical expressions.
• This type is not affected by scaling.
• It is characterized by its small storage size.
• This extension is abbreviation of (Windows Meta File).

Comparison between image extensions

-Notice:
1-All of these types of pictures are fixed except for gif type. It can be fixed and animated pictures.
2-Bmp , jpg , gif , png , wmf  are types of pictures that you can use in “VisualBasics.net” application.

3-There are many application programs that manipulate different types of pictures according to its kind
and its potentiality. Some programs enable you to convert from a picture type to another.

4-The picture file type “bmp” can be used with many operating systems.

-By using editing and processing pictures programs, the user can:

 Resizing picture
 Adding picture effects
 Cropping the picture
 Saving files with suitable extension
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Downloading Image Files through the Internet

-"Maps of Arab" states are stored within "Maps" folder inside "Atlas" folder.

-"Flags of Arab" states are stored within "Flags" folder inside "Atlas" folder.

-The images of tourist places are stored within "Pictures" folder inside "Atlas" folder.
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Dealing with Images “Editing Pictures”

imagesstaticandanimatedDesigning
program“Paint.net”by usingDesigning a static image-1

To resize the image:

From“Image”menu, choose “Resize”.

- Changing the picture direction from “Image”menu by selecting:-
- Flip Horizontal
- Flip Vertical
- Rotate 90˚ clockwise
- Rotate 90˚ counter-clockwise
- Rotate 180˚

Selecting the Image
1- Choose to select a rectangular selection.

2- Choose to select areas with same color.

3- Choose to add areas to the selection.

4- Choose “Invert Selection” from “Edit” menu to invert the selected area.

5- Choose to deselect the selected area

6- Choose to copy the selected area

7- Choose to cut the selected area

8- Choose to paste the selected area

9- Choose to crop the selected area

Before adjusting
the picture size

After adjusting
the picture size
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Photo Layers:-
1- To add new layers press
2- To delete layer press

Tools:-
1- “Gradient” tool:-

You can choose different gradient shapes from “Gradient” option bar.

And change the color form the color palette.

3- “Shapes” tool:-

1- To draw a shape, choose “Shapes” tool
2- From “Shapes” option bar, choose (Shape type, Bruch width, Style,……..,etc)

3- Color the shape by using “Paint Bucket”.

4- “Text” tool:-

To Type “Electronic Atlas”
1- Choose the “Text” tool.
2- Choose the location you want to write the title.
3- Click and start to write “Electronic Atlas”.
4- From “Text” option bar you can change the (font,color,size,……etc.)

Primary color

Secondary
color
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4- “Move the selected pixel” tool

We used this tool to select and move (relocate) any part of the design.

Adjustments

You can try every adjustment and see its effect on the picture.

Effects:-
Try every effect and see its effect on the picture.

Project 1

1- Open a new picture which width=800pixels and height=600pixcels.
Note: From “File” menu choose “New” and write the size that you want then press “ok” button.
2- Color background by using the “Gradient” tool or “Paint Bucket” tool.
3- Add a new layer.
4- In the new layer draw a shape as rectangle and color it by using the “Paint Bucket” tool.
5- Add a new layer, and then type “Electronic Atlas”.
6- Open the two images and add effects to them or apply the adjustments.
7- Select the part that you want to copy from each picture.
8- Add a new layer, and then paste the two copied pictures.
9- Save the project and the picture.
Note:
1- To save the project:- From “File” menu choose “Save As” in the “File name “ box, write project1 and in
“Save as type” box choose “Paint.net(*.pdn)”
2-To save the picture:- From “File” menu choose “Save As” in the “File name “ box, write project1 and in
“Save as type” box choose “JPEG”
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-:animated imageanDesigning

within the timeone after the other in framesincludedimagesa series of static"GIF" in the fact of the matter is
frame bar one, and is determined by the period of time between each frame to appear when the display is
moving.
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2Project
Designing a Movable Image

Use the "Swish Max 4" program to create a movable image as the waving flag.

The steps:-
1) Open "Swish Max" program.
2) From "Insert" tab ,choose "Import Image".
3) Select the image.
4) From "Modify" tab, choose "Break", then" Break into Pieces".
5) From "Break into Pieces" dialogue box, change "Break" from “Random Triangles” to “Regular Grid”.
6) Adjust the columns to be "15" and the rows to be "5".
7) Select “Triangulate all pieces”
8) Select “Inflate all pieces by”   “0.5” pixels.
9) Select first "Cascade Order", then press "Ok".
10) From "Insert" tab, choose “Effect”, "Looping Continuously", and then "Flag Waving".
11) From "Flag Waving" panel, change the “Size of flutter” into "3".
12) From "File" menu, choose "Export Setting".
13) From "Export Setting" dialogue box, choose "GIF Animation".
14) Under "Loop", change "1" times into "5" times, then press "OK".
15)  From "File" menu, choose "Export" ,"Gif Animation" and type a name to the movie.
16)  Press "Save" button.
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Questions on chapter (4)
Q1)  Put ( √ ) or  (  X  ):-

1) The picture of type “.gif” is characterized by its greater number of colors and sharpness
than the “.jpg” type. (   )
2) You can use an image editing software to delete part of a sound file. (   )
3) When creating Web sites it’ s better to use  .bmp images . (   )
4) You can add effects on pictures’ sections; by using graphic design programs (ready-made applications.(   )
5) The image of type “.wmf” has a small size compared to the .bmp type. (   )

-:Q2)Fill in the spaces

1. Type three types of image files that can be inserted, into some of the control tools in the “Visual Basic”
Language.

a) ………….        b)………….      c )………….
2. Fixed image files can take the following extensions:
a) ………….        b)………….      c )…………. d ) ……….
3. Animated pictures files take the extension........................

4. What does (Multimedia) mean and what are its components?
………………………………………………………………….
5. Mention two advantages of using (Multimedia) in education?

………………………………………………………………….

Q 3) Drag the appropriate image file name of the following to the correct cell in the table (Assuming
that all the files have the same content)
Filename.raw - Filename.doc Filename.gif - Filename.rft - Filename.png - Filename.wmf
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applications:tneVisual Basic .“) The most popular image file types that can be used in4Q
* ...............................        * ...............................
* ............................... *  ...............................

Q5) Choose the correct answer:-
1.Youcaninsertdifferenttypesofimagefilesusingthecontrol(PictureBox)except the file type:
a-.Rawb-.bmp              c-.jpg d-.gif

2. Image files take the extension
a-.wmf                    b-.bmp              c-.jpg d-all of the above

3. Animated picture files take the extension:
a-.jpg                        b-. gif              c-. png       d-. wmf
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Lesson Five
Creatingand Processing of Sound Files

There are many programs that can be used in creating and processing sound, cutting & merging it as
(Audacity) (O/S Windows- Linux)

http://audacity.sourceforge.net/
(WavePad) ( O/S Android)
The creation of a sound file requires the use of a program to record audio and then stored within the suitable file
extension.
1-There are many audio files formats (extensions) such as: wav, wma, mp3.
The following identify the famous audio types.

“WAV” Type:

1) Good quality
2) Common used in recording original sounds (Sound without modifications or effects)
3) You can edit “WAV” audio file by audio processing programs.
4) It takes huge size comparing to “MP3” so it is not recommended to be used in web sites as we have to
compress “WAV” and convert it into another format to reduce its size which leads to lose its quality.
5) This extension is abbreviation for “Waveform Audio”.

“MP3” Type:

1) The compressed “MP3” file is less quality than “WAV” type.
2) Never to use it in recording the original sound.
3) Most of the audio programs can edit “MP3” audio files.

“WMA” Type:

1) “WMA” has a higher quality than “MP3”.
2) “WMA” is supported by some of the audio processing programs.
3) “WMA” is abbreviation for “Windows Media Audio”.

Comparison between Video Extensions

http://audacity.sourceforge.net/
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Workshop One

-First: before you start recording, answer the following questions:
1- What is the theme or topic you want to record?
2- What are the sentences that will be recorded?
3- What are the sound file time, and the intervals between each sentence?
The answers of previous questions come as follows:-

-Assuming that the requested theme to be recorded is on the "Tourist Attractions in Egypt".
- Try to arrange and write a set of sentences on the most important tourist attractions in Egypt, this requires first
to take a look on the image files that you have collected with your colleagues in the subfolder " Pictures " under
the main folder"Atlas".
- The sound file is identified by the number of sentences that will be recorded.
- Let’s assume that the pictures that you search for "Tourist Attractions in Egypt",and the video file used are as

follows:

-Compose and write sentences on each of the pictures above, with the help of your teacher “Geography
teacher”, you can search through the Internet to get accurate data for these attractions.
-Type the text (to be recorded) in one of the word processing programs, and then save it.

:stepsrecording through the followingvoiceSecond: Start

- Make sure that the microphone is connected to your computer.
- Download audio recording program, by using “Windows 7”, from the “Start’ menu, choose
“Accessories”, then “Sound Record”, by using “Windows 8” , choose the “Start Screen”).
The Sound recording program appears.
-Start recording the required sentences.

-Save the sound file with filename:   "أھم المعالم السباحیة فى مصر" in the subfolder"Sounds" under the main folder
"Atlas".

- Now, the narration becomes ready, you can use it in your movie file of the "Attractionsin Egypt".
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Questions on chapter (5)

Q1)Put (√)  or ( X):-
1) You can add effects on specific tracks or to the whole file like magnification or soften the sound. (   )
2) You can use one of the audio processing programs in modifying the sound dimensions. (   )
3) .wav file takes a smaller size than .mp3 ( )
4) You can use one of the audio processing programs in repeating an audio track. ( )
5)  You can use one of the audio processing programs in deleting a part of the sound file. ( )

Q2)Complete the following table:

Audio File
Type

Application programs which can run the file

.mp3

.wav

.wma

Q3)
1-The following extensions are of the audio file type except:

a.  Wav
b.  Mp3
c.  Png
d.  Wma

2-The audio file with the least size:-
a. File name.wav
b. File name.mp3
c. File name.wma
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Workshop Two
1- Load http://audacity.sourceforge.net/ , and then download the program.

2- Open the previous audio file.

3- The audio file will appear as follows:-

-:Skill Builder
1- Open the audio file which you have saved, the program loads an audio file to read it.
2- The audio file appears in a time line represents the voice in form of frequencies and a pointer head moves on

the frequencies.
3- Through “Audio Processing Program”, you can delete a part of the sound.
4- Cut a part of the sound and paste it in another part of the same file or in another audio file.
5- Add another audio file to the current audio file.
6- Add an effect on a specific tracks or the whole file.
7- Save your file in sounds folder.

Lesson Six
Creating and Processing of Video Files

Video File Formats:-
There are different video file formats like: avi, wmv, gp , mp4.

“3gp” extension:
“3gp” video format produces a small file size of low quality; it is appropriate for mobile cameras and

applicable with mobiles phones 'operating systems.
“Mp4” extension:

“Mp4” video format produces average file size of high quality compared with “3gp” extension; it is
appropriate for “Mp4” devices.

“Avi” extension:
“Avi” video format produces a large file size of high quality compared with other formats; “Avi” video

format is appropriate to computers and video cameras.
Whereas : in “VB.net” language, you can insert the appropriate controls in the(Toolbox) to run different

types of video files.
Comparing between 3gp , Avi and Mp4

3gp Mp4 Avi
Size Small Average file size Large file size

Quality Low High quality compared with
3gp

High quality compared with
Other formats

Appropriate
for

Mobile
camera

Mp4 devices Computers and video
cameras

http://audacity.sourceforge.net/
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Video editing software
It is the software that enables the user to create and modify videos (film material) and audio through a

variety of tools and effects that help the user in creating and editing videos easily and quickly.

There are many video editing applications that manipulate different video file formats (extensions);
according to supported features for each of them. Some programs allow you to convert from one
video file format to another. Also you can find a program that supports videos and pictures and play
sounds.
 Kdenlive ( O/S Linux)

http://kdenlive.org/
 Video Maker (O/S Android)

http://play.google.com/store/apps/details?id=yong.app.videoeditor
 Movie Maker (O/S Windows )
http://windows.microsoft.com/en-us/windows/get-movie-maker-download

There are many programs that can be used in creating and processing of video files as

Movie Maker

1- From "Start" menu, choose

Workshop Two

1- Import files (Video - Photos - Voice) by choosing "Capture Video".
2- Edit videos (add effects - writing texts) by choosing "Edit Movie".
3- Saving video within file by selecting "Finish Movie".

Importing Images:-

1- Under " Capture Video", choose "Import Pictures".
The needed pictures are found in "Picture" folder inside "Atlas" folder.

2- Click and drag the images and put them in the" Storyboard".

http://kdenlive.org/
http://play.google.com/store/apps/details
http://windows.microsoft.com/en-us/windows/get-movie-maker-download
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Notice:
When pressing "Show Time Line",the time bar will appear as following figure:-

Import an Audio File:

1-Under "Capture Video", choose "Import Audio or Music".
The needed sound is found in "Sounds" folder inside "Atlas" folder.

2-Press "Show Time Line"

3-Click and drag the audio file and place it in "Time Line" bar.

Editing Videos (adding effects - writing texts):-

1- From "Edit Movie", choose "View Video Effects".
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2-From "Edit Movie", choose "View Video Transition".
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3- From "Edit Movie", choose "View Titles or Credits" to add a text.

4- Saving video in "Videos" folder within "Atlas" folder.
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on chapter (6)sonuestiQ

Q1)Put (√)  or ( X):-
1- You can get a video file types .wmf , .wmv and .mp3 through search in the Internet. (  )
2- “MS Paint" program can be used in the modified of audio and video files. ( )
3- You can use the Internet and mobile phones to collect videos to benefit from them in the projects. (  )
4- “.3gp” video file type is considered high quality and small size video file. (  )

Q2)Mention four purposes the movie maker program can be used for?
a.  ……………
b.  …………..
c.  ………………
d.  …………….

Q3) Choose the correct answer:
1- The following extensions considered video files except:
a. .mp4
b.  .png
c. .wmv
d.  .3gp

2- The highest quality video file is:
a. .3gp
b. .mp4
c.  .wmv

3- The smallest size video file is:
a. .mpg
b. .3gp
c. .mp4

Q4)Complete the table, specify the name/names of the applications (software) that can
run every type of the following video files

Filetype Application Name

.mp4

.wmv

.avi
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Lesson Seven
Preparing of the Project Interface and Adjusting the Properties

1- Open "Visual Basic" program.
2- Create a new project under the name "Atlas".
3- Create the following interface:-

-Add 10 Labels, 2 ComboBoxes , Button , 2 PictureBox , WindowsMediaPlayer to the "Form" window ,then
adjust the properties as follows:-

-Adjust the "Name" property for the controls as shown in the table.

Notice:-
"AxWindowsMediaPlayer" control is not found in the "ToolBox".

1- To add the previous tool ,press right click inside the "Toolbox", then select " choose Items".
2- Put √ at the front of "Windows Media Player.

 Specify the controls that appear on the User Interface (window form), using the code:

Object.Visible = True

 Specify the other controls which does not appear on the User Interface (window form), using the code:

Object.Visible = False

 Adjust the SizeMode property of the PictureBox control, using the code:

Picbxmap.SizeMode = StretchImage
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Questions on chapter (7)
Q1)Put (√)  or ( X):-

1- Elements are placed inside the control tool (Combo Box) through property called Items. (  )
2- Use control tool (ComboBox) to choose only one element from the list of elements. (  )
3- Visual Basic allows the addition of new controls to the Tool Box. (  )
4- Windows Media Player can be used to open text files. (  )
5- The user can insert the animated images inside the control tool (Picture Box)

and it appear moving after the operation. (   )

Q2)Choose the correct answer:-

1- When viewing the result of a calculation in the control tool (Label), it is prefers that the value of property
(Name) to be:
a. Label 1
b. Name
c. My Name
d. lblResult

2- The most appropriate control tools that can be used to display a list of namesare:
a.  Button
b.  Picture box
c.  Label
d.  Combo box

3- The following control tools used to display images except
a. Button
b.  Picture box
c.  Label
d.  Combo box

4- Control tool that is used to run audio and video files are
a.  RadioButton
b.  WindowsMediaPlayer
c.  ComboBox
d.  PictureBox

5- Control tool used to insert a list of items inside it are
a.  Button
b.  PictureBox
c.  Label
d.  ComboBox
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(1) The form window contains many Controls. Tick (√) in front of the Controls shown below used on the
form:

(2) The modification of control names reflects its function; from the following choose the best name for the
control”PictureBox1” used to display the map of the country:
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Q3) Complete the following table:-


